
3. Georeferenciranje ortorektifikovanih aerosnimaka 

3.1  Teoretski deo 

Da bi se rasterski podaci mogli efikasno koristiti u GIS-u, neophodno je izvršiti georeferenciranje. 

Georeferenciranje je proces dodeljivanja koordinata iz realnog sveta svakom pikselu rasterske 

podloge. Uglavnom se ove koordinate dobijaju geodetskim merenjima na terenu – merenjem 

koordinata GPS uređajem za pojave koje se lako identifikuju na slikama ili kartama. U nekim 

slučajevima se koordinate dobijaju sa oznaka na karti kao što je to slučaj sa digitalizacijom 

skeniranih karata i planova. 

3.2 Zadatak 

Kreirati novi QGIS projekat i pokrenuti modul Georeferencer... iz menija Raster i izvršiti 

georeferenciranje datog skeniranog plana ili karte. Georeferenciranje vršiti na osnovu 

identifikovanih decimetarskih krstića sa označenim koordinatama na referentnoj podlozi. Kao 

parametre projekcije odabrati zvanični referentni koordinatni sistem za područje Srbije ili 

Republike Srpske u zavisnosti od zone kojoj podaci pripadaju: MGI 1901 / Balkans zone 7 (EPSG: 

3909) ili MGI 1901 / Balkans zone 6 (EPSG: 3908). 

 Korišćeni softver i podaci 

Za potrebe georeferenciranja topografske podloge koristiti verziju QGIS-a 3.16 i u okviru njega 

instaliran Georeferencer modul. 



Podaci neophodni za izvršenje zadatka: 

 Skenirani katastarski plan, osnovna državna karta ili plan katastra vodova u GeoTIFF 

formatu, 

 Koordinate decimetarskih krstića ispisane na okviru plana plana. 

Svi podaci dostupni su u MGI 1901 / Balkans zone 7 (EPSG: 3909) ili MGI 1901 / Balkans zone 

6 (EPSG: 3908) projekciji Državnog koordinatnog sistema. 

 Postupak izrade 

Korak 1: Pokretanje QGIS-a 

Pokrenuti QGIS Desktop 3.16 softverski paket dvoklikom na odgovarajuću ikonicu. Ukoliko 

ikonica nije kreirana na radnoj površini računara (engl. Desktop), program se može pokrenuti i sa 

lokacije gde je instaliran. Po podrazumevanim podešavanjima, izvršna datoteka će se nalaziti na 

putanji "C:\Program Files\QGIS 3.16\bin". Kreirati novi projekat u QGIS-u i isti nazvati 

Georeferenciranje.qgz. 

Korak 2: Učitavanje plana za georeferenciranje i određivanje koordinata okvira plana 

Učitati dobijeni katastarski plan / kartu korišćenjem komande Layer → Add Layer → Add Raster 

Layer. Ovim se pokreće dijalog Data Source Manager. Za projekciju katastarskog plana izabrati 

koordinatni sistem MGI 1901 / Balkans zone 7 (EPSG: 3909) ili MGI 1901 / Balkans zone 6 

(EPSG: 3908) projekciji Državnog koordinatnog sistema u zavisnosti od zastupljenih koordinata 

(ukoliko y koordinata iznosi oko 7 500 000, pripada 7. zoni, a ukoliko iznosi 6 500 000, pripada  

6. zoni Gaus-Krigerove projekcije Državnog koordinatnog sistema). 

Korak 3: Pokretanje modula Georeferencer... 

Za ovu vežbu je potrebno koristiti već instaliran modul Georeferencer GDAL. Pokrenuti komandu 

Raster → Georeferencer...Nakon pokretanja modula Georeferencer GDAL, pojaviće se poseban 

zaseban prozor Georeferencer u okviru QGIS-a. 

Korak 4: Georeferenciranje plana  

Postoje dve osnovne procedure georeferenciranja rasterskih slika u QGIS-u: 

1. Sama rasterska slika ponekad sadrži oznake sa koordinatama (krstiće – npr. krstiće 

decimetarske mreže kod katastarskih planova ili fotosignale orijentacionih tačaka na 

snimcima aerofotogrametrijskog snimanja) zapisanim na samom rasteru. Na ovaj način se 

koordinate mogu ručno uneti, što je i ovde slučaj. 



2. Korišćenjem već georeferencirane podloge (slojeva). Ovo mogu biti vektorski ili rasterski 

podaci koji sadrže iste objekte/pojave koje se nalaze i na planu ili slici koju treba 

georeferencirati i sa projekcijom koja treba da se dodeli rasterskoj slici. U ovom slučaju se 

koordinate unose kliktanjem na referentnu podlogu, koja je učitana u QGIS okruženje. 

Uobičajena procedura za georeferenciranje slike uključuje kreiranje više tačaka na rasteru, unos 

odgovarajućih koordinata i odabir relevantnog metoda transformacije za rektifikaciju podloge. Na 

osnovu ulaznih parametara i podataka, modul će izvršiti proračun world fajl parametara (fajl sa 

parametrima georeferenciranja istog naziva kao i raster sa ekstenzijom .tfw). Što se više koordinata 

obezbedi, bolji će rezultati biti. 

Stoga se ova vežba može uraditi na dva načina, korišćenjem već datih koordinata kontrolnih 

tačaka ili preuzimanjem koordinata objekata koji se mogu identifikovati na slici koja se 

georeferencira i na ortorektifikovanoj podlozi kao referentnoj. 

Rasterska slika se učitava u Georeferencer klikom na dugme Open Raster  i pokazivanjem 

na lokaciju slike na disku pri čemu treba uneti i parametre projekcije koordinatnog sistema u kom 

se ta slika nalazi (EPSG: 3909). 

Korak 5: Zadavanje referentnih tačaka pikira decimetarskih krstića  

Koordinate referentnih tačaka potrebno je očitati sa plana, iste su nanete na okviru plana a potrebno 

je proceniti i koliko iznose koordinate pojedinih decimetarskih krstića na osnovu rastojanja na 

plana. 

Korišćenjem dugmeta Add Point , nova tačka se dodaje u radno okruženje QGIS 

Georeferencer-a i unose se njene koordinate. Za ovu proceduru postoje tri mogućnosti: 

1. Klikom na tačku na rasterskom planu i unosom X i Y koordinate redom ručno (Slika 3-1), 

https://docs.qgis.org/2.18/en/_images/mActionAddGCPPoint.png


 

Slika 3-1. Zadavanje koordinata kontrolne tačke u donjem desnom uglu plana 

Kod ovog pristupa potrebno je identifikovati što je moguće više pikira decimetarskih 

krstića kako bi se georeferenciranje valjano sprovelo u svim delovi rasterske podloge (po 

okviru a i unutrašnjosti plana). 

2. Klikom na tačku na rasterskoj slici i odabirom dugmeta From map canvas  da bi se 

unele koordinate pomoću georeferencirane rasterske podloge koja je već učitana u QGIS 

prikaz karte (npr. neki ortofoto snimak ili OSM mape). 

3. Korišćenjem dugmeta Move GCP Point  , mogu se pomerati kontrolne tačke u oba 

prozora ukoliko su prvobitno određeni na pogrešnom mestu, a takođe se mogu menjati i 

koordinate kontrolnih tačaka unete u tabelu. 

Nastaviti sa unosom kontrolnih tačaka. Potrebno je odrediti bar četiri tačke u ćoškovima plana a 

još je bolje ukoliko se više tačaka izmeri jer će i rezutati biti bolji. Postoje i druge alatke navedenog 

modula koje se koriste za zumiranje i pomeranje radnog područja radi lociranja relevantnog skupa 

GCP tačaka . Za poboljšanje kontrasta slike prilikom merenja kontrolnih 

tačaka treba koristiti alatku Full Histogram Stretch . 

Tačke koje su dodate biće sačuvane u zasebnom tekstualnom fajlu ([naziv fajla].points) najčešće 

zajedno sa rasterskom slikom. Ovim se omogućava kasnije ponovno otvaranje Georeferencer 

https://docs.qgis.org/2.18/en/_images/pencil.png
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plugin-a i dodavanje novih tačaka ili brisanje postojećih u cilju poboljšanja rezultata. Fajl sa 

tačkama sadrži vrednosti u formi: X karte, Y karte, X piksela, Y piksela kao koordinate ciljnog i 

pikselskog koordinatnog sistema. Mogu se koristiti i alatke Load GCP points  i Save GCP 

points  radi bolje organizacije fajlova. 

Korak 6: Podešavanje parametara transformacije 

Nakon završetka merenja kontrolnih tačaka na rasterskoj podlozi, potrebno je definisati 

podešavanja transformacije za proces georeferenciranja. Podešavanja tranformacije se pokreću 

klikom na alatku Transformation Settings  (Slika 3-2). 

 
Slika 3-2. Podešavanje parametara transformacije za potrebe georeferenciranja plana 

Tipovi transformacija 

Trenutno, dostupni su sledeći tipovi transformacija: 

 Linearni algoritam se koristi samo za kreiranje world fajla i drugačiji je od svih drugih 

algoritama budući da se ne vrši transformacija rastera. Ovaj algoristam najverovatnije neće 

biti dovoljan ukoliko se radi sa skeniranim podlogama (kartama, planovima). 

 Helmertova transformacija izvodi prosto skaliranje i rotiranje slike. 
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 Polinomski algoritmi 1-3 su najviše korišćeni algoritmi za poređenje izvornih i ciljnih 

GCP-ova. Najviše se koristi polinomski agoritam drugog reda polinomske 

transformacijekoji dozvoljava određeni stepen zakrivljenja. Polinomska transformacija 

prvog reda (afina) očuvava kolinearnost i dozvoljava samo skaliranje, transliranje i 

rotiranje slike. 

 Splajn tankim pločama (Thin Plate Spline - TPS) algoritam je moderniji metod 

georeferenciranja sa kojim se mogu prepoznati lokalne deformacije u podacima. Ovaj 

algoritam je koristan kada se georeferenciraju originali lošeg kvaliteta. Ovu bi trebalo 

izabrati za većinu podloga pa i za ovu vežbu iako bi linearna u ovom slučaju bila dovoljna. 

 Projektivna transformacija predstavlja linearnu rotaciju i translaciju koordinata. 

Tipovi resamplinga (interpolacija) rastera 

Tip resamplinga koji će se koristiti zavisiće od ulaznih podataka i konačnog cilja same vežbe. 

Ukoliko ne treba da se menja statistika same slike, trebalo bi koristiti interpolaciju najbližeg suseda 

(Nearest neighbor), dok će se sa kubnom interpolacijom (Cubic resampling)mdobiti nešto 

zamućenija slika. 

U Georeferencer pluginu moguće je birati između pet različitih metoda resamlinga (interpolacije): 

1. Najbliži sused (najmanji nivo zamućenja koji će se koristiti u ovoj vežbi) 

2. Linearna 

3. Kubna 

4. Cubni Splajn 

5. Lanczos 

 

INTERPOLACIJA NA OSNOVU NAJBLIŽEG SUSEDA 

(Nearest Neighbor) 

Najjednostavnija interpolacija. Intenzitet izlaznog piksela se 

izjednači sa nivoom intenziteta ulaznog piksela koji je najbliži 

lokaciji gde se mapira izlazni piksel. 

 

BILINEARNA INTERPOLACIJA 

Interpolacija prvog reda ili bilinearna interpolacija. Vrednost 

izlaznog piksela računa se kao srednja vrednost intenziteta četiri 

piksela ulazne slike gde se mapira izlazni piksel. Težine pri 

određivanju srednje vrednosti su u korelaciji sa udaljenosti mesta 

mapiranja izlaznog piksela do četiri susedna piksela. Pri 

geometrijskim operacijama, smothing efekat bilinearne 

interpolacije može degradirati fine detalje slike. 



 

BIKUBNA INTEPOLACIJA  

Vrednost izlaznog piksela računa se kao srednja vrednost 

intenziteta šesnaest (4x4) piksela ulazne slike gde se mapira izlazni 

piksel. Težine pri određivanju srednje vrednosti su u korelaciji sa 

udaljenosti mesta mapiranja izlaznog piksela do šesnaest susednih 

piksela 

Postoji nekoliko opcija koje je potrebno definisati za izlazni georeferencirani raster: 

 Opcija Create world file je dostupna jedino ako se koristi linearni tip transformacije, zato 

što ovo znači da rasterska slika zapravo neće biti transformisana. U ovom slučaju, 

polje Output raster nije aktiviran, zato što će samo world fajl biti kreiran. 

 Za sve druge tipove transformacija, potrebno je definisati izlazni raster (Output raster). Po 

default-u, novi fajl ([naziv fajla]_modified) biće kreiran u istom direktorijumu zajedno sa 

originalnom rasterskom slikom koja se georeferencira. 

 Kao sledeći korak, potrebno je definisati ciljni koordinatni sistem Target SRS (Spatial 

Reference System) za georeferencirani raster (EPSG: 32634 za ovu vežbu). 

 o potrebi može se generisati pdf karta a takođe i izveštaj u formi pdf-a. Izveštaj sadrži 

informacije o korišćenim parametrima transformacije, slici reziduala (odstupanja) i spisak 

sa svim GCP-ovima i njihovim srednjim kvadratnim greškama. 

 Može se štiklirati i polje Set Target Resolution i definisati rezolucija piksela izlaznog 

rastera (ostaviti po default-u, biće 5cm veličina piksela kao i za ulazni ortofoto). 

 Sa štikliranom opcijom Use 0 for transparency when needed svi pikseli sa vrednošću 0 će 

biti prikazani transparentno (providno). 

 Konačno, sa štikliranom opcijom Load in QGIS when done izlazni raster će se automatski 

učitati u radno okruženje QGIS-a kada se završi transformacija. 

U zavisnosti od broja snimljenih kontrolnih tačaka zavisi i koji će se algoritam transformacije 

koristiti. Izbor algoritma transformacije zavisi i od tipa i kvaliteta ulaznih podataka i količine 

geometrijskih distorzija koje će biti sadržane u izlaznom rezultatu. 

Obavezno definisati parametre projekcije ciljnog koordinatnog sistema u kom će bit sačuvan 

georeferencinrani plan a moguće je formirati i izveštaje u PDF-u sa prikazom karte sa vektorima 

odstupanja i celog izveštaja transformacije (Slika 3-3). 



  

 Slika 3-3. Izgled dela izveštaja o georefernciranju plana 

 

Korak 7: Georeferenciranje 

Nakon što su izmerene sve potrebne kontrolne tačke i sva podešavanja transformacije definisana, 

potrebno je kliknuti na dugme Start georeferencing  kako bi se kreirao nov georeferencirani 

plan. Učitavanjem u QGIS i preklapanjem sa drugom ispravno georeferenciranom podlogom može 

se proveriti da li je ceo postupak valjano izvršen. 
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